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Preface 

Intended Audience 

This document is aimed at the following personnel: 

 Asset Manager Administrators 

Prior knowledge of Service Manager and Asset Manager is a prerequisite to 

fully appreciate the contents of this document.  

Typographical Conventions 

Courier Font: 

 Source code and examples of file contents. 

 Commands that you enter on the screen. 

 Pathnames 

 Keyboard key names 

Italic Text:  

 Filenames, programs and parameters.  

 The names of other documents referenced in this manual. 

Bold Text: 

 To introduce new terms and to emphasize important words.  

Associated Documents 

You will also find useful information in the following documents:  

Asset Manager Documentation:  

o Procurement 

o Installation and upgrade guide 

o Administration guide  

o Tailoring guide 

Connect-It documentation:  

o HP Connect-It User's guide 

Service Manager Documentation:  

o HP Service Manager installation manual 

o HP Service Manager documentation online help: http://<HP Service 
Manager documentation server>/help/index.jsp 
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Chapter 1 

Introduction 

This document aims to provide a general understanding of the different aspects 

and components of the HP Service Manager-Asset Manager integration. It 

explains important concepts, key components and how communication between 

these different components functions.   

 

The following chapters will be covered in this document: 

 Overview and Global Architecture 

 User Interface Integration 

 What is in the Catalog 

 The Request Creation 

 Request Creation Troubleshooting 

 Recommendations 

 Frequently Asked Questions  
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Chapter 2 

Overview 

The purpose of this chapter is to present the main key components of the 

integration, their role and also the various relationships between them.     

2.1 Global Architecture 

 

Figure 1: Global Architecture 

 

But first, some important notions need to be defined or clarified:  

 Asset Manager (AM) is a complete IT management system that lets users 

manage a portfolio and the events associated with the lifecycle of the 

items in the portfolio: Procurement, cost management (tax, TCO, 

maintenance contracts, work orders, etc.).  

 HP Service Manager (SM) is the application used to manage the 

“Employee Self Service” (ESS) Catalog. Throughout this guide, all 

references to HP Service Manager will always be in relationship to using 

this specific catalog.  

 Web Service Proxy is an interface that is used to convert a query to 

create a purchase request from the HP Service Manager catalog into a 

series of calls to the Asset Manager Web Service which enables the 

purchase request to be created in Asset Manager. 

 Connect-It is an EAI (Enterprise Application Integration) type integration 

platform. It is used to integrate different applications from which it can 

obtain or to which it can provide internal data (Internal support, 

equipment management software, etc.) or external data (ERP, B2B, B2C).  
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It is used to:  

 Enable the Single Sign-On (SSO) configuration 

 Publish the Catalog from the Asset Manager database to the HP 

Service Manager database 

2.2 Seamless Graphical User Interface Integration 
The HP Service Manager and Asset Manager integration provides a user-friendly 

way to perform procurement requests in a single interface. 

 

Figure 2: Graphical User Interface integration  

 

As the schema shows above, the HP Service Manager interface is fully integrated 

in the Asset Manager Webtier interface.  

An Asset Manager user can easily access all HP Service Manager functionalities 

without having to re-authenticate thanks to the SSO mechanism. 

Also in the Asset Manager Webtier navigation area this integration provides both 

the Asset Manager and HP Service Manager navigation bars to allow quick and 

easy access to both application interfaces.  

 

CWC CWC 

Application Server Application Server  

 

 
Asset Manager 

 

 
Service Manager 

  
  SM 

AM Web Client 



10 

2.3 System Synchronization 
Data synchronization between Asset Manager and Service Manager is done using 

Connect-It.  

Connect-It is delivered with a set of scenarios to synchronize data from the Asset 

Manager database to the HP Service Manager database:  

- Login information for employees who will need to create requests  

- Employees 

- Models 

- Standard requests  

- Products 

- Off-catalog 

- Request status update 

 

 

Figure 3: System synchronization  

 

The HP Service Manager Request Self-Service Catalog consists of:  

 Items that users can choose at the time of their request  

 Categories into which items can be classified 

 

The synchronization populates the HP Service Manager catalog with different 

types of items from Asset Manager: 

Service Manager Asset Manager 

Connect-It  
WS DLL 
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 Products: These are items from the Products (amCatProduct) table 

 The standard requests from the Request (amRequest) table 

 Models for off-catalog products from the Model (amModel) table 

During data synchronization, models defined in Asset Manager are also published 

in the HP Service Manager catalog as categories.  

Asset Manager employees defined in the Employee table (amEmployee) are 

propagated in HP Service Manager as Contact and Operator. 

The different rules and conditions used for mapping and publication will be 

described in Chapter: 4.1 What is a catalog item. 

2.4 Self-Service Request Creation 
The Self Service Request is the request created by a user through the HP Service 

Manager Self-Service Catalog to acquire goods. 

Once the data has been synchronized between the HP Service Manager Database 

and the Asset Manager Database, users can now create requests using the Self -

Service catalog. 

The Request is created in HP Service Manager and all request processing (quote, 

order, receiving,...) is managed in the Asset Manager application (if the items of 

the request are from the Asset Manager database).  

 

Figure 4: Self Service Request  
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The request is created in the HP Service Manager interface, validated in HP 

Service Manager and sent to the Web Service Proxy module. The Web Service 

Proxy module creates an Asset Manager request and sends it to Asset Manager.  

Once the order has been satisfied, a Status request update is sent from Asset 

Manager to HP Service Manager to change the status of the Service Manager 

request.  

 

Figure 5: Request Creation Process 
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Chapter 3 

User Interface Integration 

The seamless integration of HP Service Manager within Asset Manager gives 

users the capability to manage a whole procurement request from a single 

interface. 

3.1 General aspects  
The aim of the integration is to provide, in one single interface, access to Asset 

Manager and HP Service Manager applications.  

After configuring the HP Service Manager–Asset Manager integration, in the 

Asset Manager Webtier you should find:  

- Two navigation bars in the navigation tree of the Asset Manager Webtier 

interface  

- Access to Asset Manager windows and HP Service Manager windows once you 

have logged in 

3.2 Single Sign-On 
Single Sign-On (SSO) is an access control method which requires that users only 

authenticate once before accessing several applications, Asset Manager and the 

HP Service Manager back-end. Users only need to log on once to access both 

applications.  

In order to use Single Sign-On (SSO), the same logins must be used in both the 

Asset Manager and Service Manager databases. 

 

Before explaining the Single Sign-On setup, the following paragraph clarifies the 

notion of Contact and Operator in HP Service Manager. 

In HP Service Manager, a person who contacts the service desk to initiate a 

service desk interaction, incident, or change, or a person who uses components 

tracked in Configuration Management is registered as a Contact and a user who 

has access rights and security settings is an Operator. The operator can log in to 

the HP Service Manager application. All operator instances are based on a contact 

instance.   

Personal information like company, the department name, the group, the 

employee ID are stored in the contact. Data about a user's role, profiles, login 

information, the startup pages, etc, are stored in the operator. 

The recipient of a request is a Contact and the request has to be submitted by an 

Operator. So, in the HP Service Manager and Asset Manager integration, the HP 
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Service Manager database and the Asset Manager database must be synchronized 

in order to share the requester and recipient request information.    

To share the information, Connect-It provides two out-of-the-box scenarios named 

users.scn and sso.scn which are used to synchronize information between Asset 

Manager and HP Service Manager. 

 

For each Asset Manager user, a Service Manager contact will be created with the 

scenario users.scn. The new contact will have as fullname the Asset Manager 

employee Name and Firstname.  

For each of these new contacts coming from the Asset Manager database an 

Operator is created by the sso.scn scenario and their fullname is also the Asset 

Manager employee Name and Firstname. These Operators are created using the 

Service Catalog template (“Template-Service Catalog”).  

Important 

The mapping between the fullname and the Asset Manager employee Name and 

Firstname is mandatory and is fully managed by the scenario provided. This is 

the recommended way.  
 

The Service Catalog template is provided with the Service Manager demo 

database. It defines the Employee Self Service Execute Capabilities, the startup 

page and the how the Self Service menu can be accessed.  

Each new operator will have: 

 The User Role: SELF SERVICE 

 The User Profile: SELF SERVICE 

 The email address filled with the Asset Manager value 

 

At startup, the newly created user will have the following Execute Capabilities:  

 partial.key 

 partial.key.msg.skip 

 service desk 

 service catalog 

 change request 

 svcCatEmployeeRequester 

 svcCatDeptRequester  

 

This user will also have Self Service information filled in automatically, the “Self 

Service Menu” field will have the value “ESS-Service Catalog” and the “Self 

Service starting page” field will be set to the value “Request from catalog”.  
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Warning 

To allow users to properly connect to the request self-service system, the profile 

template has to be updated before launching the synchronization.  

Via the HP Service Manager client and a user who has administration rights (for 

example, falcon). 

1. Open the Navigation/ System Administration/ Ongoing Maintenance/ 

Operators menu.  

2. Search for the Template-Service Catalog record (enter Template-Service Catalog 

in the Login Name field and click Search). 

3. Check the Self Service Access Only checkbox.  

4. In the Startup notebook tab, Execute Capabilities section, add 

svcCatEmployeeRequester to the first empty line of the table.  

5. Save your changes. 
 

  

Note 

In the event you are integrating an HP Service Manager Catalog already 

populated with Asset Manager operator contact, you will need to customize the 

provided Connect-It scenarios before synchronizing data.  
 

3.2.1 Mapping Asset Manager Employee and Service Manager 
Contact 

The Connect-It users.scn scenario creates or updates HP Service Manager 

Contact instances from the Asset Manager Employees and Departments table 

(amEmplDept).  

It uses the following fields in the Employees and Departments table to select the 

employee to propagate: 

 

Node name 
Description Data type or sub-

structure 

BarCode Barcode identifier  String 

FirstName First name String 

Name Name String 

Email 
E-mail address of the 

employee or department 
String 

UserLogin 

User name allowing the 

employee to connect to the 

database.  

String 

bDepartment Specifies whether the record Short 
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Node name 
Description Data type or sub-

structure 

describes a department or 

an employee 

 

The following table gives the mapping between the Asset Manager table 

attributes and the Service Manager Contact instance fields:  

 

Service Manager Contact  

Characteristics  

Asset Manager amEmplDept 

attributes 

ContactName BarCode 

FirstName FirstName 

FullName Name & FirstName 

LastName Name 

 

Note 

For more detail about the Connect-It scenario, you can directly view or create the 

scenario documentation from the Connect-It interface via the File menu's “Create 

a scenario documentation” or “view HTML scenario documentation” menu items.  
 

3.2.2 Mapping the Asset Manager Employee and Service Manager 
Operator 

The Connect-It sso.scn scenario creates or updates HP Service Manager Operator 

instances from the Asset Manager Employees and Departments table 

(amEmplDept).  



17 

It uses the following fields in the Employees and Departments table to select the 

employee to propagate: 

 

Node name Description Data type or sub-structure 

UserLogin 

User name allowing the 

employee to connect to the 

database.  

String 

FirstName First name String 

Name Name String 

BarCode Barcode identifier  String 

 

The following table provides the mapping between the Asset Manager table 

attributes and the Service Manager Operator instance fields:  

 

Service Manager Operator 

characteristics 

Asset Manager amEmplDept 

attributes 

ContactName BarCode 

FullName Name & FirstName 

Name UserLogin 

SysTemplate "Template-Service Catalog" 

 

Note 

For more detail about the Connect-It scenario, you can directly view or create the 

scenario documentation from the Connect-It interface via the File menu's “Create 

a scenario documentation” or “view HTML scenario documentation” menu items.  
 

3.3 Navigation Bar aggregation 
To ease navigation between Asset Manager and HP Service Manager, the Asset 

Manager Web and HP Service Manager Web menus can be aggregated.  

After aggregation, menus for Asset Manager Web and HP Service Manager Web 

are grouped in the same navigator.  

The Asset Manager navigation menu is displayed under a new menu node named 

“AssetManager” and the Service Manager navigation menu is displayed under the 

new menu node named “Catalog”.  
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Note 

The aggregation is not a merge of the navigation bars, it displays both navigation 

bars in the same interface.  
  

 

Note 

The name of the new menu nodes are customizable (“AssetManager” and 

“Catalog”). They are defined during the configuration of the Asset Manager Web 

Tier's web.xml file to get the menu aggregation. The value “Catalog” of the 

“webtier-7.01:label” parameter can be replaced by any other string. This is also 

the case of the value “AssetManager” of the “AssetManager:label” parameter.  

<filter> 

<filter-name>Navigator forwarder</filter-name> 

<filter-class>com.hp.ov.cwc.web.navMenu.CwcNavFilter</filter-class> 

... 

<init-param> 

<param-name>AssetManager:label</param-name> 

<param-value>AssetManager</param-value> 

</init-param> 

... 

<init-param> 

<param-name>webtier-7.01:label</param-name> 

<param-value>Catalog</param-value> 

</init-param> 

... 

</filter> 
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Figure 6: Aggregated Navigation Bar  

 

The Service Manager Webtier should be installed with the ESS setup which 

provides access to the ESS pages (ess.do) from the Asset Manager webtier.  

 

To access the HP Service Manager Web interface there are two possible links:  

 http://<hostname>:8080/webtier-7.01/index.do (full view is the default 

mode)  

 http://<hostname>:8080/webtier -7.01/ess.do (ESS catalog view) 

 

If the ESS mode is activated:  

 The access by the index.do URL or by the ess.do URL gives access to the 

ESS catalog and some request management menus (Submit, View, Find).  

 

If the ESS mode is not activated: 

 The access by the index.do URL gives access HP Service Manager 

“Favorites and Dashboards” and the “Menu Navigation”.  

 The access by the ess.do URL gives only access to the TO DO list (Even if 

the ESS navigation bar is displayed).  
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If the user does not have access to the ESS pages in the integrated interface, 

activation of the ESS mode should be checked.  

In the Service Manager Webtier file named web.xml (located in the 

<TOMCAT_HOME>\webapps\webtier-7.01\WEB-INF directory), the essuser 

has to be activated as in the following sample:  

    <init-param> 

      <param-name>essuser</param-name> 

      <param-value>true</param-value> 

    </init-param> 

If the param-value is set to false, change the value to true and save the web.xml 

file. This file is automatically reloaded by Tomcat Server.  

 

3.4 Tailoring the User Interface 
This chapter deals with the tailoring of HP Service Manager users and the service 

Catalog screens.  

3.4.1 Setting up the Guest User with access to Service Catalog 

If a contact needs to access the Service Catalog, the HP Service Manager 

administrator will have to grant the User with the rights defined in the Service 

Catalog template (“Template-Service Catalog”). 

In the General Notebook, the Service Profile of the user will be set to “SELF 

SERVICE” value. 

In the Self Service Notebook, the value of the “Self Service Menu” field will be 

“ESS-Service Catalog” and the value of the “Self Service starting page” field will 

be set to “Request from catalog”. 

In the startup Notebook, the execute Capabilities will have these values:  

o partial.key 

o partial.key.msg.skip 

o service desk 

o service catalog 

o change request 

o svcCatEmployeeRequester  

o svcCatDeptRequester  

 

3.4.2 Grant Service Catalog access to a Named or Floating User 

In some instances a Named or Floating user needs to access the Service Catalog. 

In this case, the administrator will have to grant the user with the Self-Service 

catalog rights as described in the previous chapter: 3.4.1 Setting up the Guest 

User with access to Service Catalog.  
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3.4.3 Tailor the SM Service Catalog screens 

The HP Service Manager administrator has the possibility to tailor the Service 

Catalog screen in HP Service Manager. For more information about the tailoring, 

refer to the Service Manager Online Help, Topic:  

 Self service tailoring 

 How do I customize the self service interface 

 Configuring the self service working environment 
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Chapter 4 

What is in the Catalog 

4.1 What is a catalog item 
The purpose of this chapter is to describe which items are published in the 

catalog, how they are filtered and when the scenario associated with the items 

should be triggered.  

Standard Requests, Products and Off-Catalog products are the catalog items exported from 

Asset Manager as items to the HP Service Manager catalog.  

The Connect-It scenario provided to synchronize Standard Requests, Product 

models, products and Off-catalog products are:  

 categories.scn 

 catalogitems.scn   

4.1.1 Standard Request 

The Standard Requests are predefined configurations to create requests. For 

example they are models of bundles used for a specific profile. 

A Standard request is a composition of several elements, for instance a desktop 

with an Operating System configuration and a set of software.  

A composition can have optional elements. These elements may or may not be 

part of the request (for instance, adding an insurance policy). 

A composition can propose a “mandatory option” which is a choice between several 

possibilities. For instance, the composition contains a printer and there are 

several models of printer. In this case the requester must select one of the printer 

models proposed.  

 

A list of options is defined in the standard requests. 

There are two types of options: 

 Required options (the user must choose a product out of a selection of 

products) 

 Optional options (the user chooses to select or not select a product out of a 

selection of products) 

 

The following attributes are used to publish Standard Requests:  
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Node type:  Node name 

Description Data type or 

sub-

structure 

STRUCTURE amRequest   

__ATTRIBUTE dtStartValidity 

Validity start date 

of the standard 

request 

Date 

__ATTRIBUTE dtEndValidity 

Validity end date of 

the standard 

request 

Date 

__STRUCTURE Model   

____ATTRIBUTE BarCode 
Bar-code identifier 

of the model 
String 

____ATTRIBUTE Name Name of the model String 

__ATTRIBUTE ReqPurpose 
Short description of 

the request 
String 

__ATTRIBUTE ReqNumber Request number String 

__COLLECTION ReqLines (collection)   

____ATTRIBUTE lLineNumber 
Line number in the 

request 
Long 

____ATTRIBUTE LineDesc 

Use this field to 

quickly recognize a 

line among the 

request lines 

String 

____STRUCTURE ChoiceOf   

______ATTRIBUTE 
lLineNumber 

fQty 

Line number in the 

request Long 

____COLLECTION Choices   

______ATTRIBUTE lLineNumber 
Line number in the 

request 
Long 

____ATTRIBUTE fQty 
Quantity of items 

requested 
Double 

____STRUCTURE Model   

______STRUCTURE Nature   

________ATTRIBUTE Name Name of the nature String 
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Node type:  Node name 

Description Data type or 

sub-

structure 

__ATTRIBUTE seStatus 
Status of the 

request 
Short 

__ATTRIBUTE bRequestable 
Certified for the 

purchase request 
Short 

 

4.1.1.1 When to use 

Standard Request is used to provide a predefined request, configuration for a new 

request (for instance: a configuration for a sales engineer, a pack with a computer 

and a set of software,…).  

4.1.1.2 When to trigger the scenario 

The scenario must be initially triggered to synchronize data between Asset 

Manager and HP Service Manager and each time new Standard Requests or new 

updates need to be published.  

By default in Asset Manager Automated Process Manager, the module named 

CatalogSyncCatalogItems associated with the catalogitems.scn scenario is 

triggered once a week (every Saturday at 1:20 AM).  

4.1.1.3 Which Standard request are published 

Only standard requests that meet certain conditions will be published in Service 

Manager. The conditions are as follows: 

 The standard request is approved for the purchase request (bRequestable 

field checked) and the validity end date (dtEndValidity) is after the 

current date (or the field is empty) (Standard tab) 

 The standard request can be published in HP Service Manager: Publishable 

in Service Manager (bPubInSSC) is checked (Standard tab) 

  The standard request's model and all parent models are publishable as HP 

Service Manager categories 

 

Standard requests which do not match these conditions will not be propagated to 

Service Manager.  

 

Note 

For more detail about the Standard Request mapping and filtering, you can 

directly view or create the scenario documentation from the Connect -It interface 

via the File menu's “Create a scenario documentation” or “view HTML scenario 

documentation” menu items.  
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To cleanup Standard Requests from the Catalog, please refer to chapter: 4.3.1 

Housekeeping.  

 

4.1.2 Product 

Products are items in the amCatProduct table.  

The following attributes are used to publish Catalog Products: 

 

Node type:  Node name:  
Description Data type or 

sub-structure 

STRUCTURE amCatProduct   

__COLLECTION Contents   

__ATTRIBUTE InternalRef 

Product 

reference within 

your company 

String 

__ATTRIBUTE Description 
Description of 

the product 
String 

__STRUCTURE Model   

____ATTRIBUTE BarCode 

Bar-code 

identifier of the 

model 

String 

____ATTRIBUTE Name 
Name of the 

model 
String 

____STRUCTURE Parent   

______ATTRIBUTE bOffCat 

Select this 

option if the 

model must be 

used to create an 

off-catalog 

product in 

Service 

Manager's self-

service catalog 

Short 

______ATTRIBUTE BarCode 

Bar-code 

identifier of the 

model 

String 

______ATTRIBUTE Name 
Name of the 

model 
String 

__ATTRIBUTE dCertifEnd Certification end Date 
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Node type:  Node name:  
Description Data type or 

sub-structure 

date 

__ATTRIBUTE dCertification 
Certification 

date 
Date 

__STRUCTURE Brand   

____ATTRIBUTE Name Brand name String 

 

4.1.2.1 When to use 

A product is used to represent  an item, a set of items or a service that can be acquired. 

A given product may be acquired from different suppliers with different conditions, which are 

described in the form of catalog references. 

Example: The HP VECTRA VL 800 product is available as a reference in the Micro catalog 

and is also referenced in the Direct catalog. 

A product may correspond to a single object (a CPU) or a set of objects (a computer 

configuration). 

4.1.2.2 When to trigger the scenario 

The scenario has to be initially triggered to synchronize data between Asset 

Manager and HP Service Manager and each time new Products or new updates 

need to be published. 

By default, in Asset Manager Automated Process Manager, the module named 

CatalogSyncCatalogItems associated with the catalogitems.scn scenario is 

triggered once a week (every Saturday at 1:20 AM).  

4.1.2.3 Which Products are published 

Only Products that meet some conditions will be published in Service Manager. 

The conditions are as follows:  

 The product has no components 

 The product is approved (Certification field) and the certification end date 

(dCertifEnd) is after the current date (Acquis. tab) 

 The product can be published in HP Service Manager: Publishable in 

ServiceManager (bPubInSSC) field is checked (Acquis. tab) 

 The product's model's parent as well as all parent models (hierarchically 

linked models) are publishable as categories in HP Service Manager  

Products with sub-products are not managed.  

 

Note 

For more detail about the Product mapping and filtering, you can directly view or 

create the scenario documentation from the Connect -It interface via the File 
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menu's “Create a scenario documentation” or “view HTML scenario 

documentation” menu items.  
 

To cleanup Products from the Catalog, refer to chapter: 4.3.1 Housekeeping. 

4.1.3 Off Catalog 

The Off-Catalog Products are the items in the amModel table. 

The following attributes are used to publish Off-Catalog Products:  

 

Node type Node name 
Description Data type or 

sub-structure 

STRUCTURE amModel   

__ATTRIBUTE BarCode 
Bar-code identifier 

of the model 
String 

__STRUCTURE Parent   

____ATTRIBUTE BarCode 
Bar-code identifier 

of the model 
String 

____ATTRIBUTE Name 
Name of the 

model 
String 

____ATTRIBUTE bPubInSSC 

Select this option 

if the model can 

be exported into 

Service Manager's 

self-service 

catalog 

Short 

 

4.1.3.1 When to use 

These off-catalog products allow users to choose an article that is not in the 

catalog when creating a request. Users select the off-catalog product 

corresponding to the product category that they wish to order and add a more 

detailed description of the desired product in the corresponding field.  

4.1.3.2 When to trigger the scenario 

The scenario has to be initially triggered to synchronize data between Asset 

Manager and HP Service Manager and each time new Off-Catalog Products or 

new updates need to be published.  

By default, in Asset Manager Automated Process Manager, the module named 

CatalogSyncCatalogItems associated with the catalogitems.scn scenario is 

triggered once a week (every Saturday at 1:20 AM).  
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4.1.3.3 Which Off-Catalog products are published 

Only the Models for off-catalog products that meet some conditions will be 

published in Service Manager. The conditions are as follows:  

  The model can be published in HP Service Manager  

  The model is identified as being able to be selected as off-catalog products 

(bOffCat field checked) 

  The model's model and all parent models can be published as categories in 

HP Service Manager 

  The model's model (category) possesses an inherited product  

 

Note 

For more detail about the Off-Catalog Product mapping and filtering, you can 

directly view or create the documentation of the catalogitems.scn scenario from 

the Connect-It interface by using the File menu's “Create a scenario 

documentation” or “view HTML scenario documentation” menu items.  
 

To cleanup Off Catalog Products from the Catalog, refer to chapter: 4.3.1 

Housekeeping.  

4.2 What categories are in the Catalog 

4.2.1 Categories 

Connect-It is delivered with a scenario named categories.scn in the 

<CONNECTIT_HOME>\scenario\ac\ac51\esscat directory.  

This scenario is used to export the Models from Asset Manager as categories in the HP 

Service Manager catalog. 

 

The attributes of the Model table (amModel) used to synchronize data are as 

follows: 

 

Attributes 
Description Data type or sub-

structure 

BarCode 
Bar-code identifier of the 

model 
String 

Name Name of the model String 

bPubInSSC 

Select this option if the model 

can be exported into Service 

Manager's self-service catalog 

Short 
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4.2.1.1 When to trigger the scenario 

The scenario must be triggered each time new models have been updated as 

publishable or models are no longer marked as publishable.  

By default, in Asset Manager Automated Process Manager, the module named 

CatalogSyncCategories associated with the categories.scn scenario is triggered 

once a week (every Saturday at 1:20 AM).  

4.2.1.2 How is it filtered 

Only Standard Request and Product models (categories) that are marked as 

publishable in the HP Service Manager catalog are exported.  

You can access these Models in Asset Manager via the Catalog/ Models that are 

publishable in Service Manager menu link. 

 

For the Standard request, the filtering condition is: 

 [seStatus] = 1 AND [bRequestable] = 1 AND [bPubInSSC] = 1  

 AND [Model.bPubInSSC] = 1 

 

For the Product, the filtering condition is:  

 [bPubInSSC] = 1 AND [Model.bPubInSSC] = 1 

 

4.3 Catalog and Catalog Item Updates  

4.3.1 Housekeeping 

The Connect-It ESS Catalog scenarios provided with Connect-It do not cleanup 

Catalog items in the Service Catalog when an article is removed from the Asset 

Manager Portfolio.  

The first time the scenarios are run, they expose the Asset Manager items in the 

Service Catalog database. After that, if they are configured to run periodically 

with a scheduler, they create new items in the Service Catalog when new items 

appear in the Asset Manager database and update their status when needed.  

So, in some instances an item can remain exposed in the Service Catalog even if 

the corresponding item no longer exists in the Asset Manager portfolio.  

In this case, the Service Manager administrator needs to perform housekeeping in 

the Service Catalog.  

Unfortunately there are no automatic processes to perform housekeeping and a 

manual cleanup is required. When items are removed from the Asset Manager 

Portfolio, the administrator has to delete or deactivate the corresponding 

items/bundles/categories in the Service Catalog. 

Administrators can access the items/bundles/categories in HP Service Manager 

via the Navigation->Service catalog->Manage Catalog menu and delete the 

appropriate items.  
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Chapter 5 

The Request Creation 

5.1 General 
To get the resources they need, HP Serv ice Manager users create requests us ing the 

Employee Self-Serv ice Catalog. Users choose in the Employee Self -Serv ice Catalog the items 

to put in their shopping cart. 

5.2 Request processing by the Linker 
When a user has filled his Shopping Cart using the Service Manager Catalog and 

submits his request, each Cart Item of the Request is sent in a queue and dequeue 

by the Linker. The Linker is a scheduler. It is configured to check the contents of 

the queue each minute. If it finds a request to process, it performs a call to the 

Proxy for each Cart Item. 

The Service Manager Linker (scheduler) processes all requests to the Service 

Catalog Web Service in sequential order. 

 

Figure 7: Submit Request Processing 

5.3 Request Prefixing by the Proxy 
When the Web Service Proxy creates a new Asset Manager request, it adds a 

prefix to the request's Number (ReqNumber) field. The prefix allows requests 

coming from the HP Service Manager via the Web Service Proxy to be easily 

identified. By default, the prefix value is “ESS-“; this value is defined in the 

web.xml file of the Proxy and it can be changed as described in the FAQ.  

 

 

Linker 
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Request
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Service 

Catalog 
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Services 
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Cart 
 items 

SERVICE MANAGER 
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Figure 8: Request Prefixing 

Note 

In the web.xml file, there are also four other prefixes defined. They are used by 

the Proxy in internal processing to identify the type of Request line in a request.  
 

5.4 Request Status Synchronization 
Connect-It is delivered with a scenario named status.scn which is located in the 

<CONNECTIT_HOME>\scenario\ac\ac51\esscat directory.  

This scenario is used to synchronize the status of a request in  HP Service Manager 

with the status of the corresponding request in Asset Manager. 

By default, in Asset Manager Automated Process Manager, the module named 

CatalogUpdateStatus associated with the scenario is triggered every day during a 

period of 1 hour.  

 

 

Figure 9: Request Status Synchronization  

For the request status synchronization, the following fields of the Request table 

(amRequest) are used:  

Service Manager 

Service Catalog 

Asset 

Manager 

Update 
Request status 

Connect-It  

Scheduler 

Asset Manager 

Automated 

Process 

Manager  
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Service 

Catalog Web 
Services 

 

ASSET 

MANAGER  

 

Web 

Services 

ESS-SD11-

12 

 
Request 

 
ESS-SD11012 

 

amRequest 

 

web.xml:  Prefix configuration: 

 

Request:              ESS- 

CatProduct:         CP- 

OffCatalog:          OFFC- 
OffCatalog Opt:  OCCOMMENT 
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Node name 
Description Data type or sub-

structure 

seStatus Status of the request Short 

ReqNumber Request number String 

 

In HP Service Manager, the following CartItem attributes are used for the 

update:   

 

Field Data type or sub-structure 

CartItemID Double 

Status String 

 

Below is the mapping between Service Manager CartItem fields and Asset 

Manager table attributes:  

 

Service Manager CartItem Instance 
Asset Manager amRequest 

table attributes 

Status seStatus 

 

The possible values of a Request Status are: 

 

Status Enumeration value 

In preparation 1 

Quoted 11 

Awaiting approval 13 

Validated 14 

Refused 15 

Satisfied 31 

Closed 41 

After the status synchronization, you can check the status of your request in HP 

Service Manager.  
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To access your request, use the Navigation-> Service Catalog->Search Request 

menu and check the request's status on the “Catalog Items” tab.  

If the Request is validated in Asset Manager, the Catalog item status should also 

be updated to Validated (no longer in Awaiting Approval status).  

 

5.5 Manage Orphan Requests 

5.5.1 No matching Asset Manager Request for a submitted cart 

When a cart is submitted and no matching Request is found in Asset Manager, 

you will need to investigate why this occurs. You can find investigation 

information in chapter 6.  

As there is no way to resend a submitted cart in HP Service Manager, you will 

have to delete manually the Request in Service Manager and recreate a new 

Request.  

5.5.2 A submitted cart is deleted in Service Manager  

When a submitted cart is deleted or removed in HP Service Manager, the 

associated Asset Manager request will remain active, so all HP Service Manager 

Request deletions need to be managed manually in Asset Manager.  

If the request has just been created in HP Service Manager and is really not 

useful, it can be deleted in Asset Manager by the Administrator. Otherwise, it is 

recommended to set the Request's status to “Cancelled”.  

To delete a Request in Asset Manager, use the Procurement->Purchase request 

menu, select the Request to delete and click the “Delete” button. 

To update the status of a Request in Asset Manager, use the Procurement-

>Purchase request menu, select the Request to update, change the “Req. status” 

value to “Cancelled” and click the “Modify” button.   
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Chapter 6 

Request Creation Troubleshooting 

If a Request has been submitted and nothing happens on the Asset Manager side, 

you can:  

1. Check your configuration 

2. Make sure the Service Manager Linker is started  

3. Check what is transmitted between the Service Manager Linker and the 

Web Service Proxy 

4. Check what is transmitted between the Web Service Proxy and the Asset 

Manager Web Services 

6.1 Check errors in HP Service Manager 
To check errors, review the sm.log file located in the 

<SERVICEMANAGER_HOME>\Server\logs directory.  

6.2 Check your configuration 
You can check the Connectors:  

 between HP Service Manager and the Web Service Proxy  

 between the Web Service Proxy and Asset Manager Web Services  

6.2.1 Catalog connector in HP Service Manager 

Start HP Service Manager. 

1. Select the Service Catalog/ Catalog Connectors menu.  

2. Select the connector named Open a Standard Request in Asset Manager. 

3. On the Expressions tab, enter the path to the Web Service Proxy just after 

$L.url: 

$L.url="http://<Name or IP address of the Web Service Proxy>:<Web Service 

Proxy port number>/ServiceCatalog/services/ServiceCatalog" 

For example:  

$L.url=http://ProxyServer:8081/ServiceCatalog/services/ServiceCatalog 

 

6.2.2 Web Server Proxy  

In the web.xml file check the value of the param: ServiceProviderLocation  

http://proxyserver:8081/ServiceCatalog/services/ServiceCatalog


36 

<display-name>ServiceCatalogService</display-name> 

  <context-param> 

    <param-name>ServiceProviderLocation</param-name> 

    <param-

value>http://nphung.emea.hpqcorp.net:8081/AssetManagerWebService/services/R

510/</param-value> 

  </context-param> 

 

6.3 Check that the Linker is running 
The linker scheduler in HP Service Manager ensures that the HP Service Manager 

query is transmitted to the Web Service Proxy.  

It is key to the correct operation of the integration. 

 

To check if the linker scheduler is started,  

1. Type status in a HP Service Manager command prompt.  

2. Check that linker appears in the list.  

If the linker scheduler does not appear in the list, activate the linker scheduler: 

1. Click the Start Scheduler button.  

2. Double-click linker-startup in the list.  

6.4 Check the Asset Manager Database connection 
If you have several versions of Asset Manager Database on your system, check 

which database the Asset Manager Web Service is connected to using the 

following URL:  

http://AssetManagerServer:8081/AssetManagerWebService 

Check that the Base name is the correct Database. 

   

6.5 Communication between SM Linker and Proxy  
One troubleshooting step is to check that SOAP messages are being transmitted 

between Service Manager Linker and the Proxy.  

To monitor messages being transmitted between Service Manager and the Web 

Service Proxy, you can use a utility named tcpmon. It is an open-source utility 

for monitoring data flowing on a TCP connection.  

Tcpmon will need to be placed between the AM Adapter module an d the Web 

Service Proxy. The AM Adapter is configured to connect to tcpmon, and tcpmon 

forwards the data to the Web Service Proxy. All transmitted data will be 

displayed in the tcpmon GUI.  
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Figure 10: TCPMON between SM and Proxy 

6.5.1 Configure the AM Adapter 

The AM Adapter is the module that stores the URL connection to the Web 

Service Proxy, so we need to connect the AM Adapter to tcpmon instead of the 

Web Service Proxy.  

To do this, we have to change the Catalog connector in HP Service Manager as 

follows: 

1. Start HP Service Manager. 

2. Select the Service Catalog/ Catalog Connectors menu.  

3. Select the connector named Open a Standard Request in Asset Manager.  

4. On the Expressions tab, enter the path to the Web Service Proxy just after 

$L.url:   

$L.url="http://<Name or IP address of the Web Service Proxy>:<Web 

Service Proxy port number>/ServiceCatalog/services/ServiceCatalog"  

For example:   

 
$L.url="http://ProxyServer:8085/Service Catalog/services/ServiceCatalog" 

 

6.5.2 Configure Tcpmon 

Launch the TCPMON interface and create a new TCP monitor Connection. 

Fill in the fields with:  

 Local Port: use a port number available (for example 8085)  

 Server Name: the server name of the Web Service Proxy  

 

 

PROXY 

TCPMON SERVICE MANAGER 

AM 
Adapter 

Linker 

Port: 

8081 

Port: 

8085 
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 Server Port: the port number of the Web Service Proxy (for example: 8081) 

 

Click on “Add Monitor” to start the monitoring session.  

 

 

Figure 11: TCPMON Create monitoring connection  

 

In the monitoring window you will see all messages exchanged between the AM 

Adaptor and the Web Server Proxy which will be displayed as shown in the 

example below:  
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Figure 12: TCPMON Monitoring window 

 

For testing purposes, you can easily resend a message to the server with the 

button “Submit to Server”.  

 

6.5.3 Configure Tcpmon in SOAP UI 

SOAP UI is an Open source desktop application for inspecting, invoking, 

developing, simulating/mocking and functional/load/compliance testing of web 

services over HTTP. 

In SOAP UI, once you have configured the Tools (Preferences ->Tools) javac and 

TcpMon, you can launch the TcpMon with the menu Tools->Launch TcpMon.  

 

You will get the following window:  

http://www.soapui.org/features.html#Web_Service_Inspection_and_Invocation
http://www.soapui.org/features.html#Web_Service_Inspection_and_Invocation
http://www.soapui.org/features.html#Web_Service_Development_and_Validation
http://www.soapui.org/features.html#Web_Service_Simulation
http://www.soapui.org/features.html#Web_Service_Functional_Testing
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 Figure 13: TCPMON Create monitoring connection 

Fill the fields with:  

 Listen Port: use a port number available (for example 8085)  

 Target Hostname: the server name of the Web Service Proxy  

 Target Port: the port number of the Web Service Proxy (for example: 8081)  

And click on the “Add” button.  

A new monitoring panel named with the Listen Port number will be created.  
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Figure 14: TCPMON Monitoring window 

 

For testing purposes, you can easily resend a message to the server with the 

“Resend” button.  
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6.6 Communication between Proxy and AM Web 
Services  

A second step of the troubleshooting process is to check that SOAP messages are 

transmitted correctly between the Proxy and the Asset Manager Web Services.  

 

 

 

Figure 15: TCPMON between PROXY and AM  

 

6.6.1 Configure the PROXY 

The Proxy needs to be updated to connect to tcpmon instead of the AM Web 

Service.  

To do this, in the file web.xml located in the 

<TOMCAT_HOME>\webapps\ServiceCatalog\WEB-INF\classes directory the 

param-value of the param-name ServiceProviderLocation has to be modified to 

use the host and the port number of tcpmon.  

<context-param> 

    <param-name>ServiceProviderLocation</param-name> 

    <param-

value>http://nphung.emea.hpqcorp.net:8081/AssetManagerWebService/services/R

510/</param-value> 

  </context-param> 

 

6.6.2 Configure TCPMON 

Launch the TCPMON interface and create a new TCP monitor Connection.  

 

 

PROXY 

TCPMON 
ASSET MANAGER 

AM 

Web 

Services 
port:8081 

port: 8082 



43 

 

 

Figure 16: TCPMON Create monitoring connection  

 

Fill the fields with:  

 Local Port: use a port number available (for example 8083) 

 Server Name: the server name of the AM Web Service  

 Server Port: the port number of the AM Web Service (for example: 8082)  

 

Click on “Add Monitor” to start the monitoring.  

 

In the monitoring window you will see all messages exchanged between the Web Server 

Proxy and the Asset Manager Web Services will be displayed as shown in the example 

below:  
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Figure 17: TCPMON Monitoring window 

 

6.6.3 Using Tcpmon in SOAP UI 

In SOAP UI, once you have configured the Tools (Preferences ->Tools) javac and 

TcpMon, you can launch TcpMon via the Tools ->Launch TcpMon menu.  

 

You will get the following window:  
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Figure 18: TCPMON Create monitoring connection  

 

Fill the fields with:  

 Listen Port: use a port number available (for example 8083)  

 Target Hostname: the server name of the AM Web Service  

 Target Port: the port number of the AM Web Service (for example: 8082) 

And click on the “Add” button.  

A new monitoring panel named using the Listen Port number will be created.  
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Figure 19: TCPMON Monitoring window 

 

For testing purpose, you can easily resend a message to the server with the 

“Resend” button.  
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Chapter 7 

Recommendations 

7.1 Asset Manager item duplication 
For all items in Asset Manager which can be published in the HP Service 

Manager Catalog it is highly recommended not to empty the link in case of 

duplication.  

The Asset Manager administrator can check the configuration of the table 

attributes with the Asset Manager Application Designer application. In the “Edit 

link” view, for each attribute in the “Script” Notebook, there is a check box to 

specify if the Default value is reapplied if duplication is performed or not.  

The recommendation is to not reapply default value when duplicating an item. 

The important links are: 

 “Parent” 

 "UsedReqLineAsset" 

 "UsedReqLineCntr”  

These links are used by the Web Service Proxy when mapping the HP Service 

Manager request to the Asset Manager request to recreate the Asset Manager 

product hierarchy.  

7.2 JAVA configuration 
Depending on the configuration you have chosen, you will need to increase the 

memory used by the Java Virtual Machine launched by the application servers. 

If you encountered the following memory exception (java.lang.OutOfMemoryError: 

Java heap space) you will need to increase a heap that holds objects such as 

classes and methods. 

You can increase the maximum size for the permanent generation heap with the 

MaxPermSize option.  

Example:  

 -XX:MaxPermSize=256m 

You can also increase Heap size with the option xmx  

Example: 

 -Xmx512M 
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Chapter 8 

Frequently Asked Questions 

8.1 General 

8.1.1 Why is a Model displayed as a category even if the Model is 
used by a Standard Request that has not been 
synchronized? 

The Connect-It scenario named categories.scn gets all models from HP Service 

Manager to create the Categories. No filtering is done during the population of 

the Categories from the Models. So if you have used this scenario, you may 

encounter instances where Models from Asset Manager are populated as 

Categories in Service Manager even if the Models are used by Standard Requests 

that have not been synchronized.  

8.1.2 Can an item be in more than one category in the Service 
Catalog? 

In Asset Manager an item can have only one Parent Category. Thus, the items 

coming from the Asset Manager Portfolio can only be in one category in the 

Service Catalog even if in Service Manager an item can belong to several 

categories.  

 

8.1.3 How can I publish or cancel a model publication? 

To publish or cancel publication of models in the HP Service Manager Service 

Catalog you can: 

 Use the Make the model publishable or not publishable in the HP Service Manager 

catalog wizard by clicking the SM Cat. Mngt. button (or by selecting SM 

Cat. Mngt. in the Actions... drop-down menu in the web client) in the model 

detail (Portfolio management/ Models navigation menu link).  

With the wizard you can specify that the Publishable in Service Manager 

property be propagated to all child models. 

 Manually specify the publication of a model as a category in HP Service 

Manager by checking or clearing the Publishable in Service Manager 

(bPubInSSC) checkbox in the General tab of a model detail (Portfolio 

management/ Models navigation menu link).  
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8.2 Menu aggregation 

8.2.1 Why is Service Manager menu bar not displayed in Asset 
Manager? 

There are different reasons why the Service Manager Menu bar is not displayed 

in Asset Manager.  

8.2.1.1 Configuration File web.xml 

You can check if the web.xml file has been configured correctly.  

On the machine where you installed Asset Manager Web Tier, open the 

C:\Tomcat50\webapps\AssetManager\WEB-INF\web.xml file with a text 

editor.  

You should find the text below:  

<context-param> are defined:  

<context-param> 

<param-name>aggregatedContexts</param-name> 

<param-value>AssetManager,webtier-7.01</param-value> 

</context-param> 

In the section where the <filter> is defined, you should find this filter definition:  

<filter> 

<filter-name>Navigator forwarder</filter-name> 

<filter-class>com.hp.ov.cwc.web.navMenu.CwcNavFilter</filter-class> 

<init-param> 

<param-name>AssetManager:label</param-name> 

<param-value>AssetManager</param-value> 

</init-param> 

<init-param> 

<param-name>webtier-7.01:label</param-name> 

<param-value>Catalog</param-value> 

</init-param> 

<init-param> 

<param-name>webtier-7.01:url</param-name> 

<param-value>/webtier-7.01</param-value> 

</init-param> 

<init-param> 

<param-name>AssetManager:url</param-name> 

<param-value>/AssetManager</param-value> 
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</init-param> 

</filter> 

 

In the section where the <filter-mapping> is defined, you should find:  

<filter-mapping> 

<filter-name>Navigator forwarder</filter-name> 

<url-pattern>/cwc/nav.menu</url-pattern> 

</filter-mapping> 

 

Check the declaration of the Navigator forwarder before the PostSiteMesh filter. 

<filter> 

<filter-name>PostSiteMesh</filter-name> 

<filter-class>com.hp.ov.ac.web.filter.PostSiteMeshFilter</filter-class> 

</filter> 

 

If you have modified the web.xml file, restart your application server.  

 

8.2.1.2 Check Service Manager 

Check that Service Manager is running and start it if needed.  

If SSO has not been configured, you will need to login to Service Manager with 

the same information that you use for Asset Manager and login again to Asset 

Manager.  

8.2.2 Why is the Asset Manager menu bar not displayed in Service 
Manager 

There are different reasons the Asset Manager Menu bar is not displayed in 

Service Manager.  

8.2.2.1 Configuration File web.xml 

You can check if the web.xml file has been configured correctly.  

On the machine where you installed HP Service Manager Web Tier, open the 

C:\Tomcat\webapps\webtier-7.01\WEB-INF\web.xml file with a text 

editor.  

In the section where the <context-param> is defined, check that the following text 

is defined: 

<context-param> 

<param-name>aggregatedContexts</param-name> 

<param-value>webtier-7.01,AssetManager</param-value> 
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</context-param> 

In the section where the <filter> is defined, check that the following text is 

defined:  

<filter> 

<filter-name>Navigator forwarder</filter-name> 

<filter-class>com.hp.ov.cwc.web.navMenu.CwcNavFilter</filter-class> 

<init-param> 

<param-name>webtier-7.01:label</param-name> 

<param-value>Self-service catalog</param-value> 

</init-param> 

<init-param> 

<param-name>AssetManager:label</param-name> 

<param-value>AssetManager</param-value> 

</init-param> 

<init-param> 

<param-name>AssetManager:url</param-name> 

<param-value>/AssetManager</param-value> 

</init-param> 

<init-param> 

<param-name>webtier-7.01:url</param-name> 

<param-value>/webtier-7.01</param-value> 

</init-param> 

</filter> 

 

In the section where the <filter-mapping> is defined, check that the following text 

is defined 

<filter-mapping> 

<filter-name>Navigator forwarder</filter-name> 

<url-pattern>/cwc/nav.menu</url-pattern> 

</filter-mapping> 

 

If you have modified the web.xml file, restart your application server.  

 

8.2.2.2 Check the user log in Asset Manager 

Check that Asset Manager is running. If it is not then start it.  
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If Single Sign-On has not been configured, you will need to log in to Asset 

Manager with the same login as the one you use in Service Manager and also log 

in to Service Manager. The menu aggregation should be displayed after a refresh 

of the window.  

8.3 HP Service Manager 

8.3.1 How to check if the linker scheduler is activated 

The linker scheduler in HP Service Manager ensures that the HP Service Manager 

query is transmitted to the Web Service Proxy.  

You need to make sure that the linker scheduler has been enabled. To do this:  

1. Type status in a HP Service Manager command prompt. 

2. Check that linker appears in the list.  

If the linker scheduler does not appear in the list, activate the linker scheduler: 

1. Click the Start Scheduler button.  

2. Double-click linker-startup in the list. 

8.3.2 Why are some item prices set to $0? 

Items coming from the Asset Manager Demo Database are not populated with 

their prices. In Service Manager, the items are displayed with the price of $0, but 

this is not the price used for the Request on the Asset Manager side. The correct 

value will be used.  

 

8.4 Web Service Proxy 

8.4.1 How to generate the ServiceCatalog.war file 

To generate the ServiceCatalog.war file, follow the steps described below:  

1. In the <Asset Manager installation folder>\esscat\build\ 

folder, duplicate the ant.properties.default file and rename the 

duplicated file as ant.properties.  

2. Open the ant.properties file in edit mode and change the ws.host, ws.port 

and ws.service parameters to have the 

http://<ws.host>/<ws.port>/<ws.service> link point to the machine where 

Asset Manager Web Service is installed.  

If you like, also modify the gen.dir variable to have it point to the folder 

where you want the procedure to generate the web application (the Web 

Service Proxy).  

3. Open a DOS command line prompt and change to the <Asset Manager 

installation folder>\esscat\build\ folder. 

Execute the following command:  

ant all 
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4. This creates a ServiceCatalog.war file that needs to be deployed in your 

application server.  

8.4.2 How to deploy the ServiceCatalog.war file  

For example, if your application server is Tomcat:  

Open the Tomcat Web Application Manager. In the WAR file to deploy section, 

specify the path to your ServiceCatalog.war file and click Deploy.  

Note 

If you are using an application server other than Tomcat, deploy the 

ServiceCatalog.war file on your application server following the standard 

procedure.  
 

As the Web Service Proxy acts as a link between HP Service Manager and Asset 

Manager Web Service, you will need to configure the links between these 

elements. 

To configure the link between HP Service Manager and the Web Service Proxy, 

configure the Catalog connector in HP Service Manager as follows: 

1. Start HP Service Manager. 

2. Select the Service Catalog/ Catalog Connectors menu.  

3. Select the connector named Open a Standard Request in Asset Manager.  

4. On the Expressions tab, enter the path to the Web Service Proxy just after 

$L.url: 

$L.url="http://<Name or IP address of the Web Service Proxy>:<Web Service 

Proxy port number>/ServiceCatalog/services/ServiceCatalog"  

For example:  

$L.url="http://ProxyServer:8080/Service Catalog/services/ServiceCatalog"  

Since the Java virtual machine launched by the application serv er uses a lot of 

memory, you need to increase the memory used to at least 256MB. To do so, 

modify the JVM (Java Virtual Machine) MaxPermSize parameter with the 

following switch:  

-XX:MaxPermSize=256m 

If you are using the Tomcat application server, proceed as follows:  

1 Start the Tomcat configuration console (Start/ All Programs/ Apache Tomcat 

5.5/ Configure Tomcat Windows menu). 

2 Select the Java tab. 

3 Add the following line to the Java Options section: 

-XX:MaxPermSize=256m 

4 Quit the Tomcat configuration console. 
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8.4.3 How to enable traces in the Proxy 

Create a file named log4j.properties in the directory: 

<TOMCAT_HOME>\webapps\ServiceCatalog\WEB-INF\classes 

With the following content: 

log4j.rootLogger = ERROR, stdout, fileout  

 

log4j.appender.stdout = org.apache.log4j.ConsoleAppender  

log4j.appender.stdout.layout = org.apache.log4j.PatternLayout  

log4j.appender.stdout.layout.ConversionPattern = %d{ABSOLUTE} %5p - %c - 

%m%n 

 

log4j.appender.fileout = org.apache.log4j.RollingFileAppender  

log4j.appender.fileout.File = AssetManagerProxy.log 

log4j.appender.fileout.MaxFileSize = 500KB 

log4j.appender.fileout.MaxBackupIndex = 5 

log4j.appender.fileout.layout = org.apache.log4j.PatternLayout  

log4j.appender.fileout.layout.ConversionPattern = %d{ABSOLUTE} %5p - %c - 

%m%n 

 

log4j.logger.com.hp.ov.ac.catalog = ERROR, fileout  

log4j.logger.com.hp.ov.auth = ERROR, fileout  

log4j.logger.com.hp.ov.sm.servicecatalog = ERROR, fileout  

log4j.logger.package com.hp.servicecatalog = ERROR, fileout  

log4j.logger.org.apache = ERROR, fileout  

You will need to restart the Application Server to take into account the new trace 

setting. 

8.4.4 How to modify the prefix added to Standard Request number 

When the Web Service Proxy starts the creation of a new request in the Asset 

Manager database, it adds a prefix to the Number (ReqNumber) field of the 

request. By default, this prefix is ESS-.  

If you wish to modify this prefix, you will have to perform the following actions:  
1.  Run the HP Connect-It scenario editor. 

2.  Open the status.scn scenario located in the <installation folder in HP Connect-

It>\scenario\ac\ac51\esscat folder (File/ Open menu). 

3.  In the Scenario diagram window: 

a.  Right-click with the mouse on the Asset Manager box. 

b.  Select the menu Edit a document type.... 

c.  Display the row detail of amRequest (amRequest). 

d.  Select the amRequest row. 

e.  In the WHERE Clause: field, rep lace ESS- 
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f.  Validate (OK button). 

4.  Save the changes (File/ Save menu). 

5.  Open the web.xml file of the Web Service Proxy located in the <Tomcat 

installation folder>\webapps\ServiceCatalog\WEB-INF folder with 

a text editor. 

6.  Search fo r the RequestCreationPrefix parameter et replace the ESS- value with the same 

prefix that you have used in the status.scn scenario. 

7.  Save the changes. 

 

8.4.5 Why do I get an “Insufficient rights” error 

With the Proxy traces activated, you may get the following error:  

10:38:12,271 ERROR - 

com.hp.ov.sm.servicecatalog.provider.proxy.ServiceCatalogProviderProxy - 

com.hp.ov.ac.catalog.CatalogException was caused by: 

com.hp.ov.ac.catalog.CatalogException: Error saving request 'null'  

com.peregrine.ac.AmException: Error (12,008): You do not have 'enter during 

creation' right on field 'Priority (Priority)' in table 'Requests (amRequest)'.  

Insufficient rights 

 

10:38:12,275 ERROR - 

com.hp.ov.sm.servicecatalog.provider.proxy.ServiceCatalogProviderProxy - 

[Ljava.lang.StackTraceElement;@a484ca 

Response:  

Message:    Error creating request 'REQUEST IN ERROR' (id: ESS-SD11010) 

Error saving request 'null'  

com.peregrine.ac.AmException: Error (12,008): You do not have 'enter during 

creation' right on field 'Priority (Priority)' in table 'Requests (amRequest)'.  

Insufficient rights 

 

com.peregrine.ac.AmException: Error (12,008): You do not have 'enter during 

creation' right on field 'Priority (Priority)' in table 'Requests (amRequest)'.  

Insufficient rights 

        , caused by com.hp.ov.ac.catalog.CatalogException: Error saving request 

'null' 

com.peregrine.ac.AmException: Error (12,008): You do not have 'enter during 

creation' right on field 'Priority (Priority)' in table 'Requests (amRequest)'.  

Insufficient rights 

 

Status:     FAILURE 

Return Code: -1 
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In this case, you have to check that:  

1. The Asset Manager Web Service is connected to the right Database.  

Open a browser with the Asset Manager Web service URL: 

http://AssetManagerServer:8080/AssetManagerWebService/ 

And check that the Base name has the expected value.  

2. The user performing the request has the Asset Manager User Role: Self -

service catalog requester. (in Asset Manager, Menu Organization-

>Employee, select your user in the employee list and the “Profile” 

Notebook).  

3. In Asset Manager the user has the rights to create a Request (try to create 

a new request with the Procurement->Purchase Request menu)     

http://assetmanagerserver:8080/AssetManagerWebService/
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8.5 Connect-It 

8.5.1 In which order should the ESS Catalog Connect-it scenarios 
be run? 

The ESS Catalog Connect-It Scenarios delivered in the ac/ac51/esscat directory 

should be run in the following order to correctly populate the Service Manager 

Catalog: 

 
Synchronized objects HP Connect-It 

scenario 
Asset Manager 
tables 

HP Service Manager 
Service 

Employees 
users.scn 

amEmplDept 

 

Contact 

 
Logins for employees who may need 

to create requests 
sso.scn 

 

amEmplDept 

 

Operator700 

 
Standard request  

and product models 
categories.scn  

 

amModel 

 

ServiceCatalog 

 
Standard requests,  

products 
and off-catalog products 

catalogitems.scn  

 

amRequest, 

 
amCatProduct, 

amModel 

ServiceCatalog 

 

Status of the request status.scn amRequest UpdateCartItem 

8.5.2 Which Connect-It context? 

The Connect-It context supported by the Service Manager Asset Manager 

integration is the sc62server.  

By default, in the Connect-It scenarios used with the ESS Catalog, the Context 

Path of the ServiceCenter Web Service Connector has the value sc62server/PWS.  

 

8.6 Asset Manager Web Service 

8.6.1 How to specify the Asset Manager database accessed by 
Asset Manager Web Service? 

To specify the target database to which Asset Manager Web Service connects, edit 

the following file located in: <Asset Manager installation 

folder>\websvc\package.properties 

This file contains a set of properties that determine the database configuration. 

These are prefixed with DB.  

Locate the DB.datasource property. Specify the name of the connection you wish 

to use.  

Note: You will probably need also to change the login (DB.login) and password 

(DB.password) associated with the database.  
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Example: 

 

   DB.engine=MSSQL 

# The name of the database (e.g. 16.157.134.163/myAmDb or AMDemo51en)  

#DB.datasource=AMDemo51en 

DB.datasource=NEW_CONNECTION  

# The database engine login id 

#DB.login=itam 

DB.login=NEW_LOGIN  

# The password corresponding to this login. The promptForPwd and encrypt 

parameters apply to this 

# property, so this value may be overridden by a value input at deploy time and/or 

encrypted.  

#DB.password=Hk9pv/o7lA3mlV1/7cz3Aw== 

DB.password=NEW_PASSWORD  

encrypt=true 

# Whether the DB cache is enabled 

DB.cache.enabled=true 

# The cache directory 

DB.cache.dir=C:/tmp 

# The cache size in KB (1048576 = 1GB) 

DB.cache.size=1048576 

# The owner of the DB  

DB.owner= 

# The path to the aamapi51 library  

DB.library.path=C:/Program Files/HP/Asset Manager 5.11 en/bin/aamapi51.dll  

 

# AssetManager UserLogin for WebService impersonation  

AssetManager.DB.UserLogin=Admin 

# AssetManager password for WebService impersonation  

AssetManager.DB.UserPwd=bmkBcCAZLK4= 

 

Once the file has been modified, go to the directory:  <Asset Manager installation 

folder>\deploy  

Execute the command line:  

build.bat <full name of package.properties> (Windows)  

or  
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build.sh <full name of package.properties> (Unix).  

This deployment script will propagate your changes from package.properties to 

the web.xml of the AssetManagerWebService.war package in the directory 

<Asset Manager installation folder>\websvc 

For more information, refer to Asset Manager’sInstallation guide: chapter 

Installing, configuring, removing and updating Asset Manager Web , 

section: Installing Asset Manager Web Services . 

This section includes information about password encryption.  

 

CAUTION: the parameters just set in the web.xml may be overridden in the 

AssetManagerWebService.xml file if you are using Tomcat as an application 

server. 

In addition to updating package.properties and web.xml, you also need to 

update the database parameter in  the AssetManagerWebService.xml file, as 

in the following example. By default this file is located in the directory: <Asset 

Manager installation folder>\websvc\config 

 

<?xml version="1.0" encoding="UTF -16"?> 

<Context path="/AssetManagerWebService" reloadable="true" 

docBase="C:\Program Files\HP\Asset Manager 5.10 

en\websvc\AssetManagerWebService.war"> 

 <Environment name="AssetManager.DB.Name" value="AMDemo51en" 

type="java.lang.String" override="false"></Environment>  

 <Environment name="AssetManager.UserLogin" value="Admin" 

type="java.lang.String" override="false"></Environment>  

 <Environment name="AssetManager.UserPwd" value="bmkBcCAZLK4=" 

type="java.lang.String" override="false"></Environment>  

… 

</Context> 
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HP Service Manager Administration 

HP Service Manager Administration information is available in the Service 

Manager documentation and online help.  

How to apply a license key 
Refer to the documentation: HP Service Manager Installation guide, chapter: 

Server installation (Obtaining Product Licenses).  

How to a start/stop SM7 Server 
For information about starting and stopping servers, see the HP Service Manager 

to the Service Manager online help.  
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Support 

HP Software support Web site  

You can visit the HP Software Support web site at:  

www.hp.com/go/hpsoftwaresupport 

This Web site provides a list of contacts and information about products, services 

and support provided by HP Software.  

HP Software online software support provides users with self-healing services to 

help them resolve their problems. It also provides a quick and efficient means to 

access interactive technical support tools to manage specific issues. As a technical 

support customer, you can use the support site to:  

 Search for knowledge documents of interest  

 Submit and track support cases and enhancement requests 

 Download software patches 

 Manage support contracts 

 Look up HP Software support contacts 

 Review information about available services  

 Enter into discussions with other software customers  

 Research and register for software training  

Most of the support areas require that you register as an HP Passport user and 

sign in. Many also require a valid support contract. To find more information 

about support access levels, go to: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html  

Limited responsibility clause  

Asset Manager is integrated with several third-party applications. 

Examples: Database engines, Web servers, single sign-on software, load-balancing 

and clustering hardware and software solutions, reporting software such as 

Crystal Reports, etc. 

Support for these applications is limited to their interface with Asset Manager.  

Support does not cover installation problems, setup and customization problems 

nor malfunctioning of the third-party application.  
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